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1 Overview 
Three environments or websites encompass the SAS® Clinical Trial Data Transparency system: 

• Research Environment  

• How to access: Log on to the SAS Solutions OnDemand Secure Portal 
(https://shqaccess.ondemand.sas.com/dana-na/auth/url_3/welcome.cgi).  From the landing 
page, click the Clinical Trial Data Transparency Research Environment link.  A remote terminal 
server session launches, requiring an additional logon (with same account). You then access the 
Research Environment. 

• Tasks you can perform: 
o Perform research work using SAS Clinical Trial Data Transparency or R. 
o Collect files for export from the Research Environment. 
o Review user guides and how-to videos. 

• SAS Clinical Trial Data Transparency (CTDT) Portal:  

• How to access:  Log on to the SAS Solutions OnDemand Secure Portal 
https://mseportal.ondemand.sas.com/ctdt/ 

• Tasks you can perform: 
o Import files into the Research Environment. 
o Receive exports from the Research Environment. 
o Administrators can review reporting. 

• SAS Secure Access Management:  

• How to access: Enter https://www.ondemand.sas.com/sam/ from your browser for access 
through the internet. 

• Tasks you can perform: 
o Set-up your password for the first time.  
o Reset your password. 
o Administrators can add and update users. 

Note: Once you setup your password and challenge questions, you are required to accept the Terms of 
Use Agreement in the SAS Clinical Trial Data Transparency Portal.  Accepting these terms 
unlocks your account in the SAS Clinical Trial Data Transparency Repository system, which is 
available at the Research Environment desktop. 

https://shqaccess.ondemand.sas.com/dana-na/auth/url_3/welcome.cgi
https://mseportal.ondemand.sas.com/ctdt/
https://www.ondemand.sas.com/sam/


Multi-Sponsor Environment: SAS CTDT User Guide Overview 

01-DEC-2017 MSE_Clinical_Trial_Data_Transparency_Users_Guide_6.0.docx Page 2 of 78 

The information contained in this document is considered confidential and covered under the terms of any SAS agreements as executed by 
Clinical Trial Data Transparency Multi-Sponsor Environment and SAS Institute Inc. 

Figure 1 provides an overview of the environments. 

Figure 1: Environment Overview 

 

Note: Your account information (user name (or user ID) and password) enable you to access all the 
components of the SAS Clinical Trial Data Transparency system. An additional security code is 
required to access the Research Environment through the secure portal. 
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2 Setting up Your Account 

2.1 Completing the Initial Email and Password Setup 
1. Receive an e-mail from SAS Solutions OnDemand with your user name (or user ID) for the SAS 

Clinical Trial Data Transparency system. To activate the account and set-up a password, click the link 
in the e-mail (Figure 2). 

Figure 2: Welcome E-Mail 

 

Note: The link in the e-mail expires after 72 hours. If you do not activate your account within 72 hours, 
visit the Account Help tab (Figure 3) at the https://www.ondemand.sas.com/sam/ website. Use 
the My password expired or I don’t know my username options. Otherwise, contact SAS 
Technical Support as follows: 

o Email: CTDTsupport@sas.com  
o URL: http://support.sas.com/ctx/supportform/index.jsp 
o North America: Call 919-677-8008 

Figure 3: Account Help 

 

https://www.ondemand.sas.com/sam/
mailto:CTDTsupport@sas.com
mailto:CTDTsupport@sas.com
http://support.sas.com/ctx/supportform/index.jsp
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2. Click the link to setup a password. The Secure Access Management system guides you through the 
process of setting up a password (Figure 4). 

Figure 4: SAS Secure Access Management  

 

Note: The Secure Access Management system provides password rules when you set a password. Your 
account’s password expires after 90 days. Beginning eight days prior to your password’s 
expiration, you receive a daily e-mail reminder to re-set your password.  

2.2 Installing and Setting Up the Security Token (One-Time Only) 
Access to the Research Environment requires a secure connection. To make this secure connection, you 
must enter your SAS Clinical Trial Data Transparency system user name (or user ID) and password and 
use a security token to provide a security code. This section outlines the steps necessary to install and 
set up the security token provided by Verisign. You only need to perform these steps once.  

1. Download the VIP Access application by visiting the website link https://vip.symantec.com/ 

https://vip.symantec.com/
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2. Click Download for Windows or Download for Mac, when appropriate, and follow the instructions 
provided (Figure 5). 

Figure 5: Download VIP Access 

 

Note: The following are instructions for Windows users. Mac users follow similar steps, but use Mac 
DMG application setup files.  
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3. To initiate the VIP Access application, select Run when prompted (Figure 6). 

Figure 6: Download and Install VIP Access 

 

4. The VIP Access Setup Wizard appears (Figure 7). Select Next for all screens, accept the terms in the 
license agreement, as well as all defaults, and select Install in the final step of the wizard screens. 

Figure 7: VIP Access Setup 
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5. Upon successful completion, the InstallShield Wizard Completed screen appears (Figure 8). Select 
Finish to launch the VIP Access application. 

Figure 8: VIP Access – Finish Installation 

 

2.3 Open VIP Access / How the Token Works 
Launch the VIP Access application (Figure 9).  You must create a Credential ID to identify your computer. 
Using the Security Code identifies you as a registered user. 

• Credential ID: This ID is machine or device-specific. You need to register this ID. (See 2.4 Registering 
Your Credential ID.) 

• Security Code: Use this code to log on to the computer that hosts the Research Environment 
through a secure portal or connection. 

• The code changes every 30 seconds, with a countdown clock next to the Security Code that 
shows the time remaining before the code is changed. 

• Selecting the copy button        next to the code copies the Security Code to the clipboard. This 
enables you to easily paste it into the required field when logging on to the Research 
Environment. 

Figure 9: VIP Access - Main Screen 
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2.4 Registering Your Credential ID 
1. Go to https://vip.sas.com/vipssp/.  

2. The Welcome to the Symantec® VIP Self Service Portal appears (Figure 10). Enter your SAS Clinical 
Trial Data Transparency system User Name (or User ID) and Password from section 2.1 Completing 
the Initial Email and Password Setup and click Sign In. 

Figure 10: Self Service Portal - Sign In 

 

https://vip.sas.com/vipssp/
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3. The Confirm Your Identity screen appears, prompting you for a location to send a temporary 
security code (Figure 11). Choose an option and click Continue. 

Figure 11: Confirm Your Identity 
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4. Select Email Address (recommended). An e-mail containing a temporary VIP security code (Figure 
12) is sent to the e-mail address you provided previously in the VIP setup process. 

Note: If you have any questions or need further assistance, contact the SAS Technical Support as 
follows: 

o Email: CTDTsupport@sas.com  
o URL: http://support.sas.com/ctx/supportform/index.jsp  
o North America: Call 919-677-8008   

Figure 12: Temporary VIP Security Code 

 

5. The Enter your Temporary Security Code screen appears (Figure 13). Enter your temporary VIP 
Security Code and select Sign In.  

Figure 13: Enter Your Temporary Security Code 

 

mailto:ctdtsupport@sas.com
http://support.sas.com/ctx/supportform/index.jsp
http://support.sas.com/ctx/supportform/index.jsp
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6. The Welcome to VIP Self Service screen appears (Figure 14) where you can register your Credential 
ID for use. Click Select in the VIP Credential section.  

Figure 14: VIP Welcome Screen 

 



Multi-Sponsor Environment: SAS CTDT User Guide Setting up Your Account 

01-DEC-2017 MSE_Clinical_Trial_Data_Transparency_Users_Guide_6.0.docx Page 12 of 78 

The information contained in this document is considered confidential and covered under the terms of any SAS agreements as executed by 
Clinical Trial Data Transparency Multi-Sponsor Environment and SAS Institute Inc. 

7. Register your credentials (Figure 15): 

• Enter a Credential Name (for example, My Work Machine). 
• Copy the current Credential ID number from the VIP Access window and paste it into the 

Credential ID field.  

Note: If you install the VIP Access application on a smart phone, and the smart phone is 
upgraded, your smart phone may change this credential ID.  You need to log on to 
https://vip.sas.com/vipssp/ and change the Credential ID to the new one.  

• Copy the current Security Code number from the VIP Access window and paste it into the 
Security Code field.  

• Click Submit. 

Note: Ensure that enough time remains in the Security Code countdown before you paste 
the code. If a new Security Code is generated before you attempt to proceed to the 
next step, you must enter the new Security Code (Figure 15). 

Figure 15: Register Your Credential 
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8. The Create Your PIN screen appears (Figure 16). Enter and re-enter a PIN that is 6 to 12 numbers 
and click Create. 

Note: This PIN is not your security code number. Use it to change any details associated 
with your registered security code. 

Figure 16: Create Your PIN 

 

9. When the PIN setup is successfully completed, the Credential Name you entered for your machine 
appears, along with your Credential ID (Figure 17).  

Figure 17: Manage Your Credentials 
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2.5 Accepting Terms in the Portal 
Before you can access files and study data in the Research Environment, you must first accept the Terms 
of Use Agreement at the SAS Clinical Trial Data Transparency Portal. 

1. Access the SAS Clinical Trial Data Transparency Portal at https://mseportal.ondemand.sas.com/ctdt/  

2. On the logon screen, enter your SAS Clinical Trial Data Transparency system User ID (or user name) 
and Password (Figure 18). 

Figure 18: SAS® Clinical Trial Data Transparency Portal Logon 

 

3. After logon is complete, Accept Terms is the only option that displays (Figure 19). Select the Click 
and review this information link. 

Figure 19: SAS® Clinical Trial Data Transparency Portal Accept Terms (Start) 

 

4. A PDF of terms appears. Review the text of the PDF. 

5. Once the review is complete, select the Next button. 

https://mseportal.ondemand.sas.com/ctdt/
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6. A statement appears enabling you to accept the terms (Figure 20). Select the Yes, I agree radio 
button and then click the Finish button. 

Figure 20: SAS® Clinical Trial Data Transparency Portal Accept Terms (Finish) 

 

7. Once the statement is accepted, a confirmation appears (Figure 21).   Click the Proceed to Home link 
to open the Home tab.    

Note: A copy of the terms accepted is available on your research access request for 
reference. 

Figure 21: SAS® Clinical Trial Data Transparency Portal (Proceed to Home) 
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3 Accessing the Research Environment 
Note:  If you have not accepted the terms at the SAS Clinical Trial Data Transparency Portal, you must 

follow those steps first.   See section 2.5 Accepting Terms in the Portal. 

Accessing the Research Environment involves two steps:  

• Connect to the SAS Solutions OnDemand Secure Portal using your user name (or user ID), 
password, and security code.  

• Log on to a remote terminal server session. (This is the computer that hosts the Research 
Environment.)  

Note: The Research Environment is not accessible from tablet computers (for example, an iPad) or 
other devices. 

3.1 Windows Users 

3.1.1 Connecting to the Secure Access Portal 

1. Visit the website: https://shqaccess.ondemand.sas.com and access the welcome screen (Figure 22). 

Figure 22: Secure Access Portal - Logon Screen 

 

2. For Username, enter your SAS Clinical Trial Data Transparency system user name (or user ID). 

3. For Password, enter your SAS Clinical Trial Data Transparency system password. 

4. For Security Code:  

a. Open your VIP Access application. 
b. Copy the Security Code by using the copy icon       . 
c. Paste the Security Code into the field. 

https://shqaccess.ondemand.sas.com/
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Note: The VIP Access application provides a 30-second countdown to copy the Security 
Code. Make sure you have at least 15 seconds left in the countdown before copying 
the VIP Security Code (Figure 23). 

Figure 23: Copy Security Code 

 

5. Click Sign In. 

6. The Welcome to the SAS Solutions OnDemand Secure Portal page appears. Click the Clinical Trial 
Data Transparency Research Environment link listed under Terminal Sessions (Figure 24).   

Note: If your account has rights to the Test/UAT system, you might see multiple choices on 
the landing page.   

Figure 24: Secure Access Portal – Welcome Screen 

 

3.1.1.1 Installing or Updating Java for Windows 
If Java is not installed on your computer or your Java version is old, a dialog appears (Figure 25).  

1. Click Update. 

Figure 25: Java Update Needed 
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2. A web site launches in a separate tab or window of your internet browser (Figure 26). Click Free Java 
Download. 

Figure 26: Download Java 

 

3. The screen changes (Figure 27). Click Agree and Start Free Download. 

Figure 27: Start Java Download 

 

4. The Java installer appears (Figure 28). Click Install. 

Figure 28: Installing Java - Screen 1 
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5. Uncheck the boxes (Figure 29). Click Next. 

Figure 29: Installing Java - Screen 2 

 

6. If certain programs are running, a dialog appears asking you to close them before continuing (Figure 
30). Save your work and click Close Programs and Continue. If a confirmation dialog appears, click 
OK. 

Figure 30: Installing Java - Close Programs and Continue 
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7. The installer begins installing Java (Figure 31). 

Figure 31: Installing Java - Screen 3 

 

8. When the installer is finished, click Close (Figure 32). 

Figure 32: Installing Java - Screen 4 
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3.1.1.2 Launching Terminal Server Session 

A terminal server session launches.  

1. If the Java(TM) needs your permission to run message appears, click Always run on this site (Figure 
33). 

2. The Welcome to the SAS Solutions OnDemand Secure Portal page appears again. Click the Clinical 
Trial Data Transparency Research Environment link listed under Terminal Sessions (Figure 24). 

Figure 33: Launching Terminal Session 

 

Note: You might be required to accept the installation of Juniper Terminal Services Client, as part of 
accessing the Research Environment (Figure 34). Click Yes. 

Figure 34: Install Juniper Terminal Services Client 
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3.1.2 Logging on to the Research Environment (Terminal Session) 

The log on screen for the computer that hosts the Research Environment (terminal server) appears 
(Figure 35 or Figure 36 depending on Windows 7 version or Windows 10 version).  

1. Select the icon with your User ID.  

Figure 35: Logging on to the Computer that Hosts the Research Environment from Windows 7 machine 

 

Figure 36: Logging on to the Computer that Hosts the Research Environment from Windows 10 machine 
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2. Enter your SAS Clinical Trial Data Transparency userid (NOTE: please make sure to first prepend 

‘vsp\’, then endter your userid e.g vsp\mse0xyz) and password, and click the arrow  icon.  The 
Research Environment appears (Figure 37). 

Figure 37: Remote Desktop Session 
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3.2 Mac Users 

3.2.1 Connecting to the Secure Access Portal 

Note: The screens in this section show the use of Safari on a Mac. The screens for other browsers can 
vary. 

1. Visit the website: https://shqaccess.ondemand.sas.com. The sign-in screen appears (Figure 38). 

Figure 38: Secure Access Portal - Sign-in Screen 

 

2. For Username, enter your SAS Clinical Trial Data Transparency system Username (or User ID). 

3. For Password, enter your SAS Clinical Trial Data Transparency system Password. 

4. For Security Code:  

• Open your VIP Access application. 
• Copy the Security Code by using the copy icon       . 
• Paste the Security Code into the field. 
• Click Sign In. 

Note: The VIP Access application provides a 30-second countdown to copy the Security Code. Make 
sure you have at least 15 seconds left in the countdown before copying the VIP Security Code. 

5. The Welcome to the SAS Solutions OnDemand Secure Portal page appears. Select the Clinical Trial 
Data Transparency Research Environment link listed under Terminal Sessions (Figure 39). 

Figure 39: Secure Access Portal - Welcome Screen 

 

https://shqaccess.ondemand.sas.com/
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6.  
If… Then… 

A Remote Office dialog appears (Figure 
41). 

Proceed to step 7. 

A Remote Office dialog is not displayed and 
you see a message about pop-ups being 
blocked (Figure 40). 

• Use Safari Preferences to allow pop-ups. 
• Once complete, return to the Welcome Screen 

(Figure 39) and click the Clinical Trial Data 
Transparency Research Environment link 
again. 

 

Figure 40: Mac – Popup Blockers 

 

Figure 41: Mac – Remote Office Dialog 
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7.  
If… Then… 

You see Missing Plug-in or Inactive Plug-in 
in the lower-right corner of the screen 
(Figure 41) 

Install Java. (See section 3.2.1.1 Java Installation 
on Mac.) 

You see Active Plug-in. Log on to the Research Environment (See section 
3.2.2 Logging into the Research Environment 
(Terminal Session)). 

3.2.1.1 Java Installation on Mac 

This section is only applicable if the Remote Office dialog indicates a Java plug-in is not available (Figure 
42).  

1. From the dialog, click the link in the lower right corner of the dialog (Missing Plug-in or Inactive 
Plugin). 

Figure 42: Mac – Remote Office Dialog (Java not installed) 
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2. A dialog appears, as shown in Figure 43. Click More info. 

Figure 43: Mac – Remote Office Dialog (Popup) 

 

3. A website launches in a separate tab or window of Safari (Figure 44). Click Agree and Start Free 
Download. 

Note: Depending on your Mac Operating System (OS), you might see a different page, and 
the version of Java might be a later version. 

Figure 44: Mac – Install Java Website 
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4. A Mac DMG install file is downloaded to your machine. Find and open the DMG file. Figure 45 shows 
an example, jre-7u25-macosx-x64.dmg. 

Figure 45: Mac – JRE DMG File 

 

5. When you open the DMG file, a dialog similar to the one below appears (Figure 46). Double-click the 
icon to start the installation. 

Figure 46: Mac – JRE DMG File 
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6. The installation screens might differ depending on your OS and the Java version being installed. Click 
Continue (Figure 47). 

Figure 47: Mac – Java Install – Screen 1 

 

7. Click Install (Figure 48). 

Figure 48: Mac – Java Install – Screen 2 
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8. You are prompted to enter for your machine’s administrator account (Figure 49). Enter this 
information and click Install Software. 

Figure 49: Mac – Install Admin Screen 

 

9. Figure 50 shows the final screen of the installation process. Click Close. 

Figure 50: Mac – Install Java Finish 
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3.2.1.2 Launching Terminal Server Session 

1. Close all dialogs and browser tabs or windows. 

2. Repeat the steps for signing in as described in section 3.1.2 Logging on to the Research Environment 
(Terminal Session), which includes: 

• Log on to https://shqaccess.ondemand.sas.com with User ID, Password, and Security Code. 
• After logging in, select the Clinical Trial Data Transparency Research Environment link on the 

welcome screen. 
• The Remote Office dialog appears. Continue to section 3.2.2 Logging into the Research 

Environment (Terminal Session). 

3.2.2 Logging into the Research Environment (Terminal Session) 

1. When the Remote Office dialog appears, an additional message is also displayed (Figure 51). Click 
Allow.  

Note: If you do not have Java installed on your Mac, you need to download it to proceed 
further (see 3.2.1.1 Java Installation on Mac). 

Figure 51: Mac – Accept Applet Dialog 

 

https://shqaccess.ondemand.sas.com/
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2. An additional security warning appears. Check the box I accept...application and click Run (Figure 
52). 

Figure 52: Mac – Allow HOBLink Dialog 

 

3. A HOBLink JWT dialog appears (Figure 53). 

• For Username, enter your SAS Clinical Trial Data Transparency system Username (or User ID). 
• For Password, enter your SAS Clinical Trial Data Transparency system Password. 
• For Domain, enter VSP. 

Figure 53: Mac – HOBLink JWT Logon 
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4. The Research Environment appears (Figure 54).  

Figure 54: Mac – Research Environment Desktop 

 

3.3 Logging off 
To log off the Research Environment, navigate to Start Menu -> Log off (Figure 55).  

Note: If you close the session window without logging off, you can return to the session in the same 
state as you left it. However, sessions do expire after a specified time period; therefore, you 
should always save your work and log off. 

Figure 55: Logging off the Research Environment 
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4 SAS® Clinical Trial Data Transparency Repository 
The SAS Clinical Trial Data Transparency Repository provides access to the data for your project, 
whether you plan to perform your analyses with SAS software or with R. 

4.1 Logging on 
1. In the Research Environment, double-click the SAS Clinical Trial Data Transparency Repository icon 

(Figure 56). 

Figure 56: SAS® Clinical Trial Data Transparency Icon 
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2. Internet Explorer opens and the SAS Clinical Trial Data Transparency Logon screen appears (Figure 
57). Enter your SAS Clinical Trial Data Transparency system Username (or User ID) and Password. 
Click Log On. 

Figure 57: SAS® Clinical Trial Data Transparency Logon Screen 

 

3. The SAS Clinical Trial Data Transparency main screen appears (Figure 58).   

Figure 58: SAS® Clinical Trial Data Transparency Main Screen 
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4.2 Organizing Tabs 
SAS Clinical Trial Data Transparency uses a tab-based interface. The tabs include: 

• Dashboard: This summarizes parts of the system. (Navigate to View -> Preferences to order this as 
the last tab as described below.) 

• Repository: This is the location of the study data for your research and the location of your research 
project area where you save your work and make files available for export.  

• Workspace: This is where you run SAS code on the study data. 

When you log on for the first time, the Dashboard view is automatically displayed (Figure 59). 

Figure 59: SAS® Clinical Trial Data Transparency Tabs 

 

Because the Dashboard tab is not heavily used for the solution, you can move it to the third position. To 
change the order of the View of tabs, you can drag and drop them into a new order, or: 

1. Navigate to View -> Preferences -> Views.  

2. Move the Dashboard tab to third position (Figure 60). 

Figure 60: SAS® Clinical Trial Data Transparency - Preferences -> Views 
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3. Click OK. The first two tabs are now Repository (your data access) and Workspace. The next time 
you log on, the Repository tab appears automatically. 

4.3 Accessing the SAS® Clinical Trial Data Transparency Repository User Guide  
The Help menu (Figure 61) provides a link to the comprehensive SAS Clinical Trial Data Transparency 
User Guide. This is also available from the SAS Clinical Trial Data Transparency Portal Help page, and 
from the desktop of the Research Environment. 

Note: Not all functionality described in this guide applies to SAS Clinical Trial Data Transparency. 

Figure 61: SAS® Clinical Trial Data Transparency - Help Tab 

  

Note: The SAS on the Web link does not work from the Research Environment because the research 
server provides very limited internet access. 

The following sections provide examples of approaches to using SAS Clinical Trial Data Transparency 
Repository for browsing data and programming in SAS. Table 1 references relevant sections within this 
document and the corresponding sections within the full SAS Clinical Trial Data Transparency Repository 
User Guide. 

Table 1: Guide Sections Related to the full SAS® Clinical Trial Data Transparency Repository User Guide 

Section in this Guide SAS Clinical Trial Data Transparency Repository 
User Guide Section(s) 

4.4 Data Access Chapter 2: Getting Started 

4.5 Browsing Data Chapter 2: The Data Explorer 

4.6 Copying Files from the Repository to the 
Workspace 

Chapter 2: Repository and Your Workspace 

4.7 Running SAS Chapter 19: SAS Sessions 
Chapter 20: Developing SAS Programs 

4.8 Producing Graphical Results Chapter 20: Developing SAS Programs 
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4.4 Data Access 
In the Repository view (Figure 62), the CTDT folder contains your research project area and studies you 
can access: 

• Research Project 

• If you are assigned Lead Researcher or Researcher permissions on the project, you can add, 
modify, and delete files. 

• If you plan to run SAS, copy files from this area to the Workspace tab to run SAS programs and 
view results. (See section 4.6 Copying Files from the Repository to the Workspace.) 

• To export files from the Research Environment, you must add them to the exports folder of your 
research project. 

• Studies 

• These are the clinical studies available for use, according to your Data Sharing Agreement.  
• You have read-only permissions. You cannot add, modify, or delete files or folders from a study.  
• If you plan to run SAS, copy files from here to the Workspace tab for inclusion into SAS programs 

you write within your research area. (See section 4.6 Copying Files from the Repository to the 
Workspace.) 

• If you plan to run R, download R-ready CSV files from the study to a folder (in My Documents) in 
the Research Environment (outside SAS Clinical Trial Data Transparency). 

Figure 62: SAS® Clinical Trial Data Transparency - Repository Tab 

  

Note: To expand the folders, click the Expand  icon.   



Multi-Sponsor Environment: SAS CTDT User Guide SAS® Clinical Trial Data Transparency Repository 

01-DEC-2017 MSE_Clinical_Trial_Data_Transparency_Users_Guide_6.0.docx Page 39 of 78 

The information contained in this document is considered confidential and covered under the terms of any SAS agreements as executed by 
Clinical Trial Data Transparency Multi-Sponsor Environment and SAS Institute Inc. 

Under a study, a number of folders (Figure 63) are available with information on that study, for example: 

• SAS_analysis and SAS_raw folders contain study data in SAS format. 

• R_analysis and R_raw folders contain study data in R-ready format (comma delimited). There is also 
an additional file for each CSV file that includes metadata describing the columns from the source 
SAS data set. 

• Other folders contain supporting information to help you understand and navigate the data sets. 
Figure 63 shows an example of a folder structure. 

Figure 63: SAS® Clinical Trial Data Transparency – Study Folders 
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Figure 64 shows three sample studies (ACME-12345, ABCP-65890, and ACME-12987), as well as an 
expanded view of an example research project area (CTDT RP-12345).  Users assigned the Researcher or 
Lead Researcher role have full permissions to create, modify, and delete folders and files within the 
research project area.  

Note: The folder structure pictured below might be different from your research project area. 

Note: Do not change the folder names imports or exports. If you change these names, you can no 
longer import files into or export files from the SAS Clinical Trial Data Transparency Repository. 

Figure 64: SAS® Clinical Trial Data Transparency – Research Area Folders 

  

SAS programs are typically stored in the programs (or similarly named) folder. 

• The imports folder is important. To bring files and supporting programs into the Research 
Environment, you must import them to this location. See section 6 Importing and Exporting for 
details on importing. 

• The exports folder is also important. To download files from the Research Environment, you must 
collect them here. See section6 Importing and Exporting for details on exporting. 
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4.5 Browsing Data 
As part of your research, you might want to browse and filter data even if you intend to use R for your 
statistical programming. The SAS Clinical Trial Data Transparency Explorer can be used for this purpose. 

Note: For full details, refer to Chapter 2: Getting Started -> Data Explorer within the SAS Clinical Trial 
Data Transparency Repository User Guide.  

An abbreviated example is described below: 

1. From within a folder, double-click the desired SAS data set (Figure 65). 
Figure 65: Opening a SAS Data Set 
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2. A view of the data set appears (Figure 66). Review the data set: 

• The columns of the data set appear on the left-hand side. 
• Below the columns pane, attributes display for the currently selected column. 
• The rest of the view displays the data contained within the data set. 

Figure 66: Data Set 

 

3. To sort, click a column heading. Figure 67 shows the filter SUBJID sorted in ascending order. 

Figure 67: Sorting Columns 
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4. For more filtering options, right-click the column (Figure 68).  

Note: Different options may be displayed for different columns.  

Figure 68: Filtering Options 

 

a. Select Statistics for a quick view of statistics that describe the currently selected column within 
the currently filtered view (Figure 69). 

Figure 69: Statistics 
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b. Select Filter to customize the filter. Figure 70 shows a filter for AGE <35 AND Sex=M. 
o The filter syntax appears above the data.  
o The total number of rows and number of filtered rows appears below the data.  

o To modify the current filter, select the Filter  icon.   

Figure 70: Modifying Current Filter 

 

4.6 Copying Files from the Repository to the Workspace  
The SAS Clinical Trial Data Transparency application consists of two primary locations for files (tabs) 
(Figure 71): 

• Repository: This is where master copies of files and programs are stored. 

• Workspace: This is where you store working copies of files, programs, and results.   

Note: Files and SAS data sets must be present in the Workspace to enable programs to 
read them. 

Figure 71: Repository and Workspace Tabs 
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1. To copy files from the repository to your workspace, locate the folder(s) in the repository tree, right-
click on it (them), and select Get Latest Version (Figure 72). 

Figure 72: Get Latest or Specific Version 
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2. The folders and files are copied to your personal workspace.  Navigate to the Workspace tab (Figure 
73). 

Figure 73: Workspace Tab 

 

3. Within Workspace, you can: 

a. Create new files. 
b. Save SAS programs. 
c. Review results.  
d. Check in (add) files to your research project area in the Repository when you complete your 

work. 
e. Copy files to the exports folder for your research project, for removal from the application. For 

details on exports, see section 6.2 Exports. 

4.7 Running SAS 
This section provides information to enable you to run SAS within the SAS Clinical Trial Data 
Transparency Repository.  SAS programs are run within a SAS Session.   

Use one of the following methods to open a SAS Session:  

• From the Menu Bar, click Tools -> SAS Session to open a SAS session with an empty Editor window. 
-Or 

• Right-click and select Open, or double-click on an existing SAS program in the Workspace tab. 

Note: SAS is not executed from the Repository tab. 

Write a new SAS program in an empty Editor window, or modify an existing SAS program that you 
opened.  Click the Submit icon on the tool bar to7 run the program in the active Editor window and 
review the log within the Log window.  A section of code can be run by highlighting it first and clicking 
the Submit icon. 
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Important Workspace Concept:  If you have not already done so, copy the files needed in your program 
from the Repository to the Workspace. (See section 4.6 Copying Files from the Repository to the 
Workspace.)  These files must be referenced in your program by prepending all paths with the special 
SAS macro variable &_SASWS_ (Figure 74). This provides SAS with the physical location of your 
personal Workspace.    

Tip: To ensure the correct path, click the Workspace tab and navigate to the file needed in your 
program. Highlight the full path displayed just under the tool bar, and then copy and paste it 
into your program. Insert the special macro variable &_SASWS_ in front of the path. 

Figure 74: SAS Session Tab 

 

SAS sessions support multiple Editor windows.  This enables you to have more than one program open 
at a time.  Use one of the following techniques to open additional Editor windows in your SAS Session: 

• Click the Open icon on the tool bar to open an existing SAS program from the Workspace. 

• Click the New icon on the tool bar to open an empty Editor window. 

• Create an empty new program in the Workspace and then open it in a SAS Session. 

• From the Workspace tab, navigate to the folder in which you want to create a new program. 
• Click the New icon. 
• Select SAS Program from the folder where you want the program to be saved (Figure 75). 
• Open the new empty program in a SAS session. 
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Figure 75: New -> SAS Program 

 

The additional items in the left-hand pane of the SAS Session window provide the following 
functionality: 

• Inputs  

• Outputs 

• Listing: Displays output produced by your program. 

• Libraries: Lists all libraries defined in your SAS Session.  You can navigate them to open and view SAS 
data sets available to your program. 

Once you have your program running to your satisfaction, save it by following these steps: 

1. Click the Save or Save As icon on the tool bar 

2. Navigate to the location in your Workspace where you want to save your program. 

3. Supply a name for your program. 

4. Click Save. 

Note: If you eventually plan to check your program into your research area in the Repository, save the 
program to a corresponding directory in your Workspace.  For example, perform a Get 
Version on the programs directory of your research area.  This places the necessary folder 
structure in your Workspace.  Then, save your program to the programs directory in your 
Workspace.  It is now in the correct location for use with the Check In feature.  (See the SAS 
Clinical Trial Data Transparency Repository User Guide for more details.) The log and listing 
windows can be saved in the same manner. 

Note: Refer to the Chapter 20 of the SAS Clinical Trial Data Transparency Repository User Guide for 
more details. 
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4.8 Producing Graphical Results 
Using SAS Output Delivery System (ODS), you can produce graphical results.  

Note: Refer to Chapter 20 of the SAS Clinical Trial Data Transparency Repository User Guide for SAS 
programming details. 

Using the same sample program, Figure 76 shows an example of sending your results to both the Listing 
tab of the SAS Session and to a PDF file. 

Figure 76: Sending Results to Other Locations 

 

The SAS Output Delivery System (ODS) provides instructions to SAS for producing a variety of different 
formats of output, such as PDF, RTF, and HTML.  In this example, all output produced by steps up to the 
ods PDF close; statement are sent to a PDF file (Figure 77).   

Note: For more details, access the SAS® 9.3 Output Delivery System: User's Guide, Second Edition, from 
Support.SAS.com. 

Figure 77: PDF Output 

 

http://support.sas.com/ctx/supportform/index.jsp
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5 Using R 

5.1 Overview 
This section provides information on transferring (or downloading) files from the SAS Clinical Trial Data 
Transparency Repository to your working area on the Research Environment so you can use them in R. It 
also describes the R packages that are available and how additional R packages can be imported and 
used.  

The general concept is: 

• Retrieve files from the SAS Clinical Trial Data Transparency Repository and copy them to your My 
Documents folder. 

• Run R programs on the relevant files. A number of R packages are provided. (See Figure 81). 

• Import and use other R packages by saving them to a folder in your My Documents folder. (See 
Figure 81). 

• Upload files and results back to your SAS Clinical Trial Data Transparency research area. 

• Move files to the exports folder in your research area to export them from the Research 
Environment (see section 5.4 Transferring Results for Export). 

5.2 Retrieving Files for Use 
1. Once in the Research Environment, use your SAS Clinical Trial Data Transparency system account to 

access the data in the SAS Clinical Trial Data Transparency Repository (see section 4.1 Logging on).  

2. Navigate to the R files you wish to use. 

3. Right-click the folder(s) and select Download (Figure 78).  
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Figure 78: Download 
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4. Navigate to your My Documents folder (in the Research Environment) and select the desired folder 
within this area (Figure 79). 

Figure 79: Select Location 

 

5. Select Save. The files are now saved to the location specified.  

Note: If folders (rather than files) are selected in SAS Clinical Trial Data Transparency for 
download (Figure 80), a ZIP file containing the files from the selected folders is 
downloaded. Expand the ZIP file to begin using them with R. 

Figure 80: Save Location 

 

6. Note the path to these files in order to use them in R and RStudio. 
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5.3 Using R and RStudio 

5.3.1 Overview 

Using R and RStudio in the Research Environment is very similar to using R on your local PC. R (console) 
32-bit and 64-bit versions (version 2.15.2) and RStudio 64-bit (version 2.15.2) are provided. Figure 81 
shows an example of the package list from R Studio within SAS Clinical Trial Data Transparency.   

Note: Your installation may include later versions of packages and/or additional base packages. 
Additional R packages can be imported as described in section 5.3.2 Importing Additional R 
Packages.  Also, some packages do not run without additional software on the Research 
Environment server.  Contact SAS Technical Support with any software issues as follows: 

o Email: CTDTsupport@sas.com 
o URL: http://support.sas.com/ctx/supportform/index.jsp 
o North America: Call 919-677-8008  

Figure 81: R Studio List of R Packages 

 

mailto:ctdtsupport@sas.com
http://support.sas.com/ctx/supportform/index.jsp
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5.3.2 Importing Additional R Packages 

Follow the steps below to add R packages that are not provided to the Research Environment.  

1. In the Research Environment, open Windows Explorer and confirm that the Library folder exists in 
your My Documents folder. If the folder does not exist, create the folder. 

• The library path can be confirmed using the .libPaths() command in the R console. The 
paths should include the user’s local library directory and the shared system level library as in 
Figure 82.  

Figure 82: R LIBPATHS 

 

2. Import R packages to SAS Clinical Trial Data Transparency using the Import function (see 6.1 
Imports).  

3. Download the package from the SAS Clinical Trial Data Transparency imports folder using the 
following steps: 

a. Navigate to the imports folder in the SAS Clinical Trial Data Transparency Repository and 
download the appropriate file(s) to a folder in your My Documents folder in the Research 
Environment. (For example, you could name this folder newpackages). 

b. Open R from the Research Environment desktop and execute the following command: 

install.packages(“[local file reference]”, repos=NULL, 
lib=.libPaths()[1]) 

This command installs the package(s) in the referenced ZIP file in the local path.  
The following example installs the survival package when the package has been placed in the My 
Documents/newpackages folder: 

install.packages(“d:/users/user ID/documents/newpackages/survival_2.37-
4.zip”, repos=NULL, lib=.libPaths()[1]) 

c. The installation of the module can be confirmed by using the commands: 
installed.packages() and/or require (packagename). 
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5.3.3 Accessing R 

To access R, double-click the R icon on the desktop of the Research Environment (Figure 83). 

Figure 83: R Desktop Icon 

  



Multi-Sponsor Environment: SAS CTDT User Guide Using R 

01-DEC-2017 MSE_Clinical_Trial_Data_Transparency_Users_Guide_6.0.docx Page 56 of 78 

The information contained in this document is considered confidential and covered under the terms of any SAS agreements as executed by 
Clinical Trial Data Transparency Multi-Sponsor Environment and SAS Institute Inc. 

The R startup screen appears (Figure 84). 

Figure 84: R Startup Screen 
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5.3.4 Accessing RStudio 
To access RStudio, double-click the RStudio icon in the Research Environment (Figure 85). 

Figure 85: RStudio Desktop Icon 
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The RStudio startup screen appears (Figure 86). 

Figure 86: RStudio Startup Screen 

 

Figure 87 shows an example of reading in a CSV file saved locally: 

Figure 87: Locally Saved CSV File 

 

This opens the RStudio view with browsing ability (Figure 88). 

Figure 88: RStudio View 
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5.4 Transferring Results for Export 
Results or files saved to your My Documents folder are not immediately available to export from the 
Research Environment. You must upload the files into the SAS Clinical Trial Data Transparency 
Repository and then queue them for export. 

1. Consider zipping the files before transferring them to SAS Clinical Trial Data Transparency. 

2. Open the SAS Clinical Trial Data Transparency Repository and navigate to the desired exports folder. 
(See section 4.1 Logging on.)  Figure 89 shows the exports folder of a research area named CTDT RP-
12345. 

Figure 89: Exports Folder 
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3. Click the Upload toolbar   icon and select Upload Files. 

4. Select the file(s) from the location where they are saved.  

5. A screen appears to transfer the files to the SAS Clinical Trial Data Transparency Repository (Figure 
90). Select Upload. 

Note: You do not need to version the files.  

Figure 90: Upload Files 
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6. The file or files are displayed in the exports folder (Figure 91). At this point, you are ready to queue 
an export from the Research Environment. For more details, see section 6 Importing and Exporting. 

Figure 91: Contents of Exports Folder 

 

Note: There are several rules regulating what can and cannot be exported from the Research 
Environment. If any files for export do not meet these rules or criteria, your export request 
requires approval before downloading to your computer. For details, see section 6 Importing 
and Exporting.  Every sponsor company involved in your research is required to grant approval. 
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6 Importing and Exporting 
To import or export files to or from your research project, you must use the SAS Clinical Trial Data 
Transparency system. 

1. If not already connected, access the SAS Clinical Trial Data Transparency Portal at 
https://mseportal.ondemand.sas.com/ctdt/  

2. On the logon screen, enter your SAS Clinical Trial Data Transparency system User ID (or user name) 
and Password (Figure 92). 

Figure 92: SAS® Clinical Trial Data Transparency Portal Logon 

  

3. The SAS Clinical Trial Data Transparency Portal opens (Figure 93). 

Figure 93: SAS® Clinical Trial Data Transparency Portal after Logon 

 

6.1 Imports 

6.1.1 Adding / Starting a Request 

1. After logging on to the SAS® Clinical Trial Data Transparency Portal, select the CTDT Options tab 
(Figure 94).  

Figure 94: CTDT Options Tab 

 

https://mseportal.ondemand.sas.com/ctdt/
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2. Select Imports: Show List.  

Note: The Home -> Options dropdown also allows direct access to options. 

3. To initiate an import, do one of the following:  

• Click the Add button  on the far right-hand side of the screen. 
-Or 

• From the Home tab > Options dropdown menu (Figure 95), select Imports: Add Request. 

Figure 95: Imports Section 

 

4. Enter a description (required) of the import request.  To import files you have previously imported, 
choose the Overwrite / Version Existing option to ensure the files replace existing ones in the 
Research Environment (specifically the relevant SAS Clinical Trial Data Transparency imports folder) 
(Figure 96).  

Figure 96: Add Import  

 

5. Click Add (Figure 96).  

6. The detail view appears (Figure 97) with the following options, allowing you to make required 
updates: 

• The Import Request pane on the left-hand side of the screen displays the following: 
o The details entered on the previous screen including ID, User, and Summary / Details. 
o The Status field shows your import request is automatically approved to start. 
o The Deleted? check box is blank.  This field is used for mistakenly added requests. Check this 

box to delete the request. The request then appears with the strikethrough text in your SAS 
Clinical Trial Data Transparency imports list. 

• The History of the import appears at the bottom of the screen. 
• The Attached Files pane on the right-hand side of the screen displays a list of the files you 

intend to import with  two links at the top: 
o Add Files: allows you to add files to your Import Request. 
o Manage Import Settings: allow you to define specific settings related to the import of your 

files. (Note: As shown in Figure 97, settings can be copied and applied to multiple files.) 
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7. Select Attach File(s) (Figure 97). 

Figure 97: Detail View 

 

8. A dialog appears for browsing and selecting a file and the target location for the imported file in SAS 
Clinical Trial Data Transparency (Figure 98).  

• Select Browse and navigate to the desired file.   
• Select the file and click the Open button.   
• The file name appears in the File: text box.  Select a target location from the drop-down list of 

research areas to which you have access.   
• If you have defined settings for another file in this Import Request (using the Manage Import 

Settings selection), you can select Copy Import Settings From: to apply the same settings to the 
current file.    

• Click Attach to add the selected file to the import request. The File: text box is cleared when the 
upload is complete.   

• Click Browse: again to add an additional file. 

Figure 98: Add File(s) 
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9. Click Back to Import Request. The files you selected are listed (Figure 99).  

Figure 99: Attached Files 

 

Note: Your files have not been imported to the relevant SAS Clinical Trial Data 
Transparency imports folder at this point. They have only been attached to the 
Import Request.  The next two sections cover the final steps in the import process. 

6.1.2 Managing Import Settings 

The default settings for imported files are to enable versioning when the files are imported into SAS 
Clinical Trial Data Transparency, and if importing a ZIP file, not to unzip it. If these settings are 
acceptable, skip to section 6.1.3 Starting the Import to start your import. Otherwise, to change these 
settings, or alter other previous settings, do the following: 

1. Select the Manage Import Settings link (Figure 100). 

Figure 100: Manage Import Settings Link 

 

2. A list of files and their import settings are displayed (Figure 101). Select the Modify link. 

Figure 101: Manage Import Settings Screen 

 

3.  The Modify screen appears (Figure 102). Select a research area from the drop-down menu and 
select Continue.  

Note: Make sure you select a research area and not a study. Files can only be imported 
into the imports folder of a research area.   

Figure 102: Modify 
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4. Select a folder from the dropdown menu and select Continue (Figure 103). 

Figure 103: Select Folder 

 

Note: Only the imports folder of the selected research area is available. You can move files 
to other locations in the research area after this import is complete. 

5. Final confirmation appears for the settings (Figure 104). Select one, both, or neither of the following 
options: 

• Unzip – If selected, the uploaded file is a ZIP file that expands (unzips) as part of the import 
process. The files are placed in the imports folder.  If the ZIP file contains a folder structure, that 
structure is created under the imports folder.  

• Version it – If selected, and the file uploaded already exists in the imports folder, a new version 
of the file is created. If the file does not exist in the imports folder, the file is indicated as a 1.0 
version in SAS Clinical Trial Data Transparency. 

6. Select Update (Figure 104).  

Figure 104: Update 

 

7. Your settings are displayed in the summary table. If you have multiple files and want the same 
settings to be used for all of them, use Copy to All to copy settings for all files (Figure 105). 

Figure 105: Copy to All 
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8. Select the previous item in the breadcrumb trail at the upper right to return to the Import Request 
Screen. 

6.1.3 Starting the Import 

1. From the Import Request screen, go to the bottom of the Import Request box  

2. Select the Start Import Run button (Figure 106). 

Figure 106: Start Import Run 

  

3. A confirmation appears. Select Yes to place your import in the queue to run. 

4. Once the import completes (within a few minutes), a refresh of the screen (Figure 107) shows that: 

• The Import Request status has changed to Import Processed. 
• An import summary file is attached to the request. 
• An import summary appears in the History panel.  

Figure 107: Import Summary 

 

5. Your files are now available in the SAS Clinical Trial Data Transparency Repository (in the imports 
folder of the location specified).  Log on to the Research Environment to work with them.  

Note: Once an import request is run, no more files can be added to the request.  A new 
request must be created to import more files. 
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6.2 Exports 

6.2.1 Adding a Request 

1. After logging on to the SAS Clinical Trial Data Transparency Portal, select the CTDT Options tab 
(Figure 108). 

Figure 108: Imports / Exports Tab 

 

2. Select Exports. 

3. To initiate an export request, do one of the following: 

• Select the Add button on the far right hand side of the screen. 

-Or 

• From the Home tab > Options dropdown menu (Figure 109), select Exports: Add Request. 

Figure 109: Exports Section 

 

4. Enter the details for the Export Request (all fields are required) (Figure 110). 

Figure 110: Add Export Request 

 

Note: The Mode selection enables you to export only the most current version of a file or 
to export all versions. (See the SAS Clinical Trial Data Transparency Repository User 
Guide for more information on file versions.) Generally, selecting Full – All File 
Versions is appropriate.  

If… Then… 

The Start Run Now option is available to run 
the export, and you do not need to modify the 
settings for the export. 

Go to section 6.2.2 Starting the Export from the 
Add Export Request Screen to start the export 
processing. 
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If… Then… 

You need to review or modify the Export Detail 
Screen or the Start Run Now option is not 
available. 

1. Uncheck the Start Run Now box if it is 
available. 

2. Click Add. 
3. Go to section 6.2.3 Export Detail Screen to 

make the necessary modifications. 

6.2.2 Starting the Export from the Add Export Request Screen 

1. Leave the Start Run Now check box selected and click the Add button (Figure 110). The Export List 
appears, showing the status of export request run as in progress.   

2. If the export has a status of Approved for View, a download icon appears next to the export list 
when the export run finishes (Figure 111).  Select the download icon.   

Figure 111: Export List Screen with Download Icon 

 

3. Enter your user ID (or username) and password to download the resulting export file. 

6.2.3 Updating the Export Detail Screen 

1. Access the Export Detail Screen using one of these two methods: 

• Click Add on a new request after deselecting the Start Run Now check box.  
- Or 

• Click the Reason for Export hyperlink from the Export List screen line for the desired export 
request.  

2. The Export Request detail screen appears. Make any necessary updates to the following options 
before starting the export process (Figure 112): 

• The Export pane on the left-hand side of the screen displays the details entered on the Add 
Export Request screen.  
o The Status is automatically assigned as Approved to Start. 
o The Deleted? check box is blank.  This field is used for mistakenly added requests. Check this 

box to delete the request. The request then appears with the strikethrough text in your SAS 
Clinical Trial Data Transparency exports list.  

• A History of the export appears at the bottom of the page. 
• The Export Paths panel enables you to update or add folders from which to export within the 

SAS Clinical Trial Data Transparency Repository.  
• Comments allows you to enter comments about the export request (for example, during 

approval steps by sponsor companies). 
• Generated Exports displays your exports. 
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Figure 112: Export Request Detail Screen 

 

3.  
If… Then… 

You want to modify one of fields in the Export 
Request panel. 

Make the desired modifications, then click 
Update Request. 

You are exporting files from only the location 
selected when creating the request. 

Skip to section 6.2.5 Starting the Export to start 
the export processing. 

You want to modify your export path(s) or 
settings. 

 Go to section 6.2.4 Updating Export Path(s) 
and Settings. 

6.2.4 Updating Export Path(s) and Settings 

1. In the Export Source Locations panel select Update / Add (Figure 113). 

Figure 113: Export Paths Section 

 

2. A list of folders and their export settings are displayed (Figure 114). To replace an existing folder 
from which files are to be exported, first delete the existing folder by selecting the X. 

Figure 114: Add / Edit Export Paths 
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3. Add a new folder (Figure 115): 

a. Select a research area from the Project dropdown menu and click Continue.  
b. Select a folder and click Continue. 

Note: In the Research Environment, exports can only include files from research area exports folders 
in the SAS Clinical Trial Data Transparency Repository.  You must move all files desired for export 
to a research area exports folder before running the export request. 

Figure 115: Select Folder 

 

4. You can also enter a name for the resulting export file in the Name of Zip File field (Figure 116). 

Note: The resulting export is a ZIP file. You can enter text for the file in the Name of Zip File field. This 
text appears at the start of the resulting ZIP file name. If you do not include text in this field, the 
name of the folder (exports) is used to name the file. The ZIP file name also includes the date 
and time of the export, regardless of whether you have entered text into the Name of Zip File 
field. 

Figure 116: Name of Zip File 

 

5. Select Add (Figure 117). 

6. The added or modified location appears in Current Paths (Figure 117). 

Figure 117: Current Paths 
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7. Click the previous link in the breadcrumbs trail in the upper-right corner to return to the Export 
Request Details screen. 

6.2.5 Starting the Export from the Export Request Detail Screen 

1. If you did not choose to start the export run from the Add Export Request screen, go to the bottom 
of the Export Request box located on the Export Request Detail screen.  

2. Select the Start Export Run button (Figure 118).  

Figure 118: Status 

  

3. When the verification screen appears, select Yes to place your export request in the queue for 
processing.  

• When the export finishes, the resulting ZIP file appears when the screen is refreshed. (Figure 
119). 

Figure 119: Attached Files / Generated Exports 

 

• If your export request meets preset rules for export, the Status appears as Export Created / 
Approved for View (Figure 120).  

Figure 120: Export Created / Approved for View 

 



Multi-Sponsor Environment: SAS CTDT User Guide Importing and Exporting 

01-DEC-2017 MSE_Clinical_Trial_Data_Transparency_Users_Guide_6.0.docx Page 73 of 78 

The information contained in this document is considered confidential and covered under the terms of any SAS agreements as executed by 
Clinical Trial Data Transparency Multi-Sponsor Environment and SAS Institute Inc. 

4. Download the file by clicking the file link in the Generated Exports section (Figure 121). You are 
required to re-enter your user ID and password to download the file. 

Figure 121: Export Available to Download 

 

Note: If you receive an error message about needing approval to download after clicking 
the file hyperlink, then your export request must go through an approval process. If 
your export request does not meet the preset rules for export, a system 
representative reviews your request and updates the Status based on the outcome. 
You are notified of Status changes through email. When the Status is modified to 
Export Created/Approved for View, you can download the export. If your request is 
in review, an additional section appears that tracks each company’s approval or 
denial (Figure 122): 

Figure 122: Company Approval(s) 
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7 Online Help 
Online help is available in the terminal server and in the SAS Clinical Trial Data Transparency Portal. 

1. User Guide and other help is available at:  http://support.sas.com.   

2. From the Research Environment desktop, open the Help and User Guide folder (Figure 123). 

Figure 123: Help and User Guide Desktop Icon 

 

-Or  

From the SAS Clinical Trial Data Transparency Portal, click Help at the top of the screen (Figure 124).  

Figure 124: Help Link 

 

3. The Help screen displays guides and how-to videos (Figure 125). To access them, click View. 

Note: QuickTime is the recommended media player to use when viewing the SAS Clinical 
Trials Data Transparency how-to videos. Using the Windows Media Player to view 
the videos hosted on the Clinical Trials Data Transparency Portal can sometimes 
result in short (one second or less) distortions in the visual display during the 
playback of some of the videos. 

Figure 125: Help Screen 

 

http://support.sas.com/
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Note: For help related to the SAS Clinical Trial Data Transparency system, you can also contact SAS 
Technical Support as follows: 

o Email: CTDTsupport@sas.com  
o URL: http://support.sas.com/ctx/supportform/index.jsp 
o North America: Call 919-677-8008  

mailto:ctdtsupport@sas.com
http://support.sas.com/ctx/supportform/index.jsp
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8 Troubleshooting 
Table 2 provides a quick reference for troubleshooting the most common issues. 

Table 2: Common issues 

Issue Steps to Remedy 

Trouble connecting to the Research 
Environment (Terminal Server Session) 

• Verify that you have performed all steps of the one-
time setup of your SAM Access Credential ID. 

• Verify that your account is not locked out, by selecting 
My account is locked in the problem menu under the 
Account Help tab at: 
https://www.ondemand.sas.com/sam. 

Lost password or account information • Visit https://www.ondemand.sas.com/sam. 
• Select Account Help. 
• Select an appropriate problem in the menu under the 

Account Help tab 
Account is locked Contact SAS Technical Support as follows: 

• Email: CTDTsupport@sas.com 
• URL: http://support.sas.com/ctx/supportform/index.jsp 
• North America: Call 919-677-8008  

Trouble viewing how-to videos in the 
Windows Media Player 

QuickTime is the recommended media player to use 
when viewing the SAS Clinical Trials Data Transparency 
how-to videos. Using the Windows Media Player to view 
the videos hosted on the Clinical Trials Data Transparency 
Portal can sometimes result in short (one second or less) 
distortions in the visual display during the playback of 
some of the videos. Distortions in the visual display do 
not occur when the videos are viewed with QuickTime. If 
Windows Media Player is the user’s default media player, 
the user may download the video and play it locally on 
their computer using a different media player.  
The videos might start and stop intermittently if the user 
is attempting to view them while using a slow internet 
connection. If the user experiences viewing problems to 
the point that the video is unwatchable, the user may 
download the video and play it locally on their computer. 
To download the how-to video to their local computer, 
the user should right click on the “View” link and select 
“Save target as…“ The user will then be prompted for a 
location to save the video. After downloading the video, 
the user may use any media player they have installed on 
their local computer to view the video. QuickTime is 
available for download 
at: https://www.apple.com/quicktime/download/ 

 

https://www.ondemand.sas.com/sam
https://www.ondemand.sas.com/sam
mailto:CTDTsupport@sas.com
http://support.sas.com/ctx/supportform/index.jsp
https://www.apple.com/quicktime/download/
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Typographical Conventions 

Blue Underline Hypertext link. Control + Click to open hyperlink target. 

Calibri Standard type style used for most text.  

UPPERCASE  Names of variables and data sets, programming statements, options, and 
other language elements when they appear in the text. Within specific 
operating environments, these elements may be case-sensitive.  
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<italics> User-supplied values, shown within angle brackets in statements where 
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Monospace Examples of programming statements in text, SAS code, and values of 
variables.  
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